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What is Pub Poker?
Pub Poker is fashioned on the coin-in-the-slot video poker machines that are found in many pubs in 
Sydney and around New South Wales (and no doubt, lots of other places too). It uses a standard 52 
card deck plus a joker and pays on a minimum winning hand of two pairs. If you win your hand you 
get five chances at doubling your money by guessing the colour of a mystery card. Play has been 
designed to loosely emulate the real thing and best of all, you can't go broke! Everything happens 
completely randomly, as it should, so the outcome of a game is basically up to you and lady luck!

The emphasis with version 2.0 has been placed on having fun and ease of use rather than including 
79 different game variations or putting you through a probabilities / statistics course. There are plenty
of video poker games that allow endless configuration after all. To this end, support is included for 
First Byte's Monologue for Windows text-to-speech software which will hopefully provide a bit of light 
relief when the going gets tough. In an effort to avoid boring repetition there are over 900 sentences 
that you may hear while playing Pub Poker. You can now also attach to the various game events any 
WAV audio files on your system's drives and, with the registered version, these settings are saved 
whenever you save a game. There is a statistics screen but it's not too heavy. This version doesn't 
include support for changing the payoffs table although, if enough requests for this feature are 
received it can be built into a maintenance release. The payoffs in version 2.0 are actually are bit on 
the generous side compared to those in version 1.0. This is due again to the philosophy that the 
game should be fun to play and from the feedback received from players of version 1.0, namely that 
it was too hard to win, it was decided to up the payoffs for some of the higher hands. So, be warned, 
if you break the bank with Pub Poker you'll probably still lose your shirt when you play the real thing!

Good Luck !

Russell Oates
Oatesoft Computer Services



New Features in Version 2.0
Auto Hold
Pub Poker can now select and hold your cards for you after the first deal!

Monologue Support
Monologue for Windows, by First Byte Corporation, a text-to-speech voice synthesiser application, is 
bundled together with a number of popular sound card packages, Sound Blaster and Media Vision to
name two. Monologue is also available for sale separately. If you have Monologue on your system 
then Pub Poker will be able to "advise" you during play if you wish. Pub Poker currently sports over 
900 unique sentences, some of which you may never hear (unless you make it your business to 
regularly get Five of a Kinds, Straight Flushes & Royal Flushes!). The registered version allows 
setting of the player's name to personalise the experience a bit more.

Player Defined WAV Files
Wave audio files can now be assigned to individual game events from within Pub Poker. 
Furthermore, the registered version will save the sound setup information whenever a game is 
saved.

Support for High Resolution Large Font Display Drivers
Pub Poker should now display correctly independent of your video driver setting.

PC Speaker and WAV Sound Combinations
The sound setup section now allows combinations of PC Speaker and Wave audio sound for various 
game events.

Statistics Screen
You can now compare your progress to that of the Pub Poker "machine" using an easy to read 
statistics screen complete with bar graph displays of your luck and skill.

Save & Load Games
The registered version supports saving and loading of individual Pub Poker sessions along with the 
various game setup options.

New Card Back Designs
Yep! Six original card back designs. Wow!?

Fiddle with Pub Poker
More an "I didn't inhale" feature than a real feature but, by double clicking within the cells of the 
gamble bar display you can adjust the look of Pub Poker. Experiment. You can change the 3D look of
labels, fonts and various colours of things.



What's Shareware?
Shareware isn't a type of software - its a method of distributing software.

Shareware software is a "try - before - you - buy" proposal. It allows computer owners to sample 
programs to see if they suit their needs. 

Its not free, just really convenient and a good deal. The buyer can avoid the slick salesperson, as 
well as paying for the fancy packaging, advertising, retail premises, warehouse rent etc. and just 
concentrate on finding software that works, written by dedicated authors who believe in their software
and stand behind it and their users.

Shareware is usually distributed very cheaply, on floppy disk or CDROM compilations that contain 
many programs, for little more than the cost of the media itself. If you have a modem hooked up to 
your computer then shareware can be obtained from amateur Bulletin Board Systems or commercial 
on-line systems like Compuserve, America On-line, Genie, Oz email - or academic networks like the 
Internet.

If you use a shareware program you have to pay for it (known as Registering) - by sending your hard 
earned dollars to the author. But, in    the dollars area, shareware is ahead too. Because shareware 
authors don't have the overheads of mainstream software vendors, the price of shareware software 
is usually a lot lower than software sitting on the shelves of retailers. This is certainly the case with 
Pub Poker 2.0.

Shareware is worth supporting. Many innovative software products are released as shareware. 
There are things being written all the time. Some are better than others, granted, but it's you, the 
software consumer that benefits in the long run when you lend your support to your chosen authors.

So you be the judge. If you like this program, if you use this program, send in your registration and 
help keep shareware the good deal that it is.

Russell Oates.    June 1994



Configuration

Choosing Game Setup from the Options menu displays the Game Options screen:

Game Options:
Cards
Auto Hold
Monologue
MIDI
Speed
Sounds for Events

See also:
Changing the Interface



Cards
Pub Poker contains five other card back designs. These can be selected by selecting an option 
number (1 - 6) in the Game Options window.



Auto Hold
If you've had a hard day Pub Poker can ease it a bit by automatically holding the best cards for you 
after your first five are dealt. Having Auto Hold set to Yes doesn't lock you in to the choices Pub 
Poker makes, you can always override the selections by clicking on the card images (or pressing the 
numbers 1 to 5 if you're using the keyboard to play).

Rules Auto Hold lives by...
After the first five cards are dealt, Pub Poker will select your cards for you if Auto Hold is set to Yes. 
When selecting cards to hold, Auto Hold follows these rules:

· If a winning hand is found (Two Pair or better) then the appropriate cards will be held.
· If the hand contains four cards of a flush and also contains a pair, the near flush will take 

precedence and the cards for it will be held.
· If a hand contains five cards of a flush but also four cards of a straight flush, the five cards of the 

flush will be held. If you have Monologue installed on your system and Advice is enabled for the 
1st Deal then you will be alerted to the presence of the possible straight flush.

· If a hand contains five cards of a straight but also four cards of a straight flush, the five cards of 
the straight will be held. If you have Monologue installed and Advice is enabled for the 1st Deal 
then you will be advised that you could consider dropping one of the cards and going for the 
straight flush.

· If a hand contains five cards of a straight or a flush but also four cards of a royal flush, the four 
cards of the royal flush will be held.

· When detecting the possibility of a straight, Pub Poker will only hold the straight if it is open 
ended. For example, if your 1st Deal contained a Six, Seven, Eight, Nine & Ace - the Six, Seven, 
Eight & Nine would be held because you may get either a Five, Ten or Joker in the 2nd Deal to 
make the straight. If on the other hand your 1st Deal comprised a Six, Eight, Nine, Ten & Ace - 
none of the cards would be held as the chances of drawing to an inside straight are very low. If 
you do get dealt an inside straight and you have Monologue installed and Advice enabled, Pub 
Poker will alert you and let you decide to hold the cards, just incase you're feeling ultra lucky!



Monologue
Monologue for Windows, a voice synthesiser application produced and copyrighted by First Byte 
Corporation, can be used with Pub Poker if it is installed on your system. Monologue is bundled with 
a number of sound card packages, Sound Blaster and Media Vision to name two. It is also available 
for sale separately. Pub Poker was written and tested using Monologue for Windows Version 1.5 
OEM.

Using Monologue for Advice
Using your Monologue for advice is simple. Just click the Enabled option in the Monologue section 
and select the stages of the game that you would like to hear about in the Auto Hold section. 
Although you may choose any combination you like, it's probably best to hear about the 1st Deal if 
you want to hear about the 2nd Deal because often reference is made to something that was spoken
about in the 1st Deal. 

When the advice is being spoken by Monologue, the mouse pointer changes to a silhouette of the 
Monologue icon - an open mouth:

During this time, the left button of the mouse is disabled and you can't select other game options, 
hold cards or click buttons etc. with the mouse. However, if you want to cut the spoken advice short 
you can click the right mouse button to end speaking of the current advice phrase immediately.

Monologue and Sound Card Game Events
Because Monologue produces speech using preformed WAV audio fragments, you cannot use 
Monologue and have Pub Poker play WAV audio files for game events at the same time. This being 
the case, if for example you have selected the sound card as the sound source for various game 
events and you THEN choose to Enable Monologue, the sources for each of the game events will be
changed over to the PC.

If Pub Poker didn't find your Monologue for Windows
The first time Pub Poker is started it will search for either FB_11K8.DLL or FB_22K16.DLL on your 
system's hard disk(s). Pub Poker looks to your PATH statement and searches each directory in it for 
the above files. If the search draws blanks then the \Windows and \Windows\System directories will 
be searched. Although Pub Poker only looks for the above files, it also requires that FB_NGN.EXE, 
FB_TIMER.DLL and FB_SPCH.DLL are also in the same directory. If Pub Poker fails to locate your 
Monologue files, and you are sure they are located on your PATH or in the \Windows or \Windows\
System directories please contact Oatesoft for further help.

If you install Monologue after installing Pub Poker



When Pub Poker is first started, it searches for Monologue on your system's hard drive(s). It looks for
the presence of Monologue files in directories included in your PATH statement which is in your 
AUTOEXEC.BAT file. When, and if it find the files, the information is recorded in the PUBPOKER.INI 
file stored in your Pub Poker directory.

If you purchase and install Monologue for Windows after installing Pub Poker you can either delete 
the PUBPOKER.INI file using File Manager or you can edit the PUBPOKER.INI file.

If you choose to delete the PUBPOKER.INI file then all of the game history recorded in it since Pub 
Poker was first started will be lost but you can be assured that Pub Poker will be correctly set up to 
use Monologue the next time you start it.

On the other hand, if you choose to edit PUBPOKER.INI you won't lose any of the information stored 
in the INI file.

Editing PUBPOKER.INI for Monologue set-up
1. Using File Manager, navigate to the directory where Monologue is installed on your hard drive(s). 
You may need to consult the documentation that came with your sound card / Monologue to help you
identify this directory. Once you have selected the Monologue directory, look for one of the following 
files:

FB_11K8.DLL      or      FB_22K16.DLL

If you find FB_11K8.DLL then your Monologue DLL type is 8. If you find FB_22K16 then your 
Monologue DLL type is 16.

2. Open the PUBPOKER.INI file using Notepad or another text editor.

3. Look for the following entries in the PUBPOKER.INI file:

[Monologue]
DLLType=0
Enabled=0

4. If your Monologue DLL type is 8 then change the DLLType part of the entry to read DLLType=8. If 
you have a DLL type of 16 then change the entry to read DLLType=16.

5. Save the changes you just made to PUBPOKER.INI.

6. Start Pub Poker and you should now be able to use Monologue.

Please note - If you don't have Monologue on your system, changing the Monologue entry in the 
PUBPOKER.INI file may cause an error in Pub Poker.

Please Note...
Pub Poker employs FB_TRANS.DLL, a dynamic link library written by Stephen Murphy (CIS email: 
70661,2461). FB_TRANS.DLL allows utilisation of First Byte's Monologue for Windows. Pub Poker's 
use of Monologue for Windows is not intended to violate First Byte's copyright of Monologue for 
Windows nor is it intended to condone or encourage violation of First Byte's copyrights. Pub Poker is 
not associated with First Byte, Media Vision, Creative Labs or any other vendor or supplier of 
Monologue for Windows.





MIDI
Pub Poker allows you to play your favourite Musical Instrument Digital Interface (MIDI) files whilst 
playing the game. As long as your sound card supports MIDI files, you can set a MIDI file to play 
irrespective of other Pub Poker sound option settings you may have chosen, including Monologue.

Simply click the Load MIDI button and select a MIDI file to load. The MIDI section will then look like:

You may now select to play the file only once or have it repeat over and over.

· To Play a MIDI file click:

· To Stop a MIDI file click:

· To Rewind a MIDI file click:



Speed
Dealing speed is set by choosing one of the options listed under the Speed section. The bike 
equates to a slow deal, the cars to medium and the plane to fast.

Keep in mind that the sound source you have selected to accompany the card deal and gamble flip 
events will have some effect on the speed of the deal. The fastest deal can be obtained by selecting 
no deal sound source for the deal events, next fastest is PC Speaker sound followed in last place by 
the Sound Card.



Sounds for Events
The quick route
You can quickly setup the sound sources for the game events by clicking one of the buttons shown 
below.

· No Sound does what it says - everything will be silent (but if you have a sound card and 
Monologue you can still enable Monologue).

· PC Speaker sets all events to play through the PC Speaker.
· Sound Card sets all events to use WAV audio files.

After selecting one of the quick sound buttons you can then go ahead and customise the sound 
setup further if you like. If you have a sound card and you also have Monologue installed AND the 
Sound Card button is greyed out don't worry - you'll just have to disable Monologue first, then the 
Sound Card button will be useable.

The custom way...
Don't worry, its not as complicated as it looks.. think of it as versatile!

The Sound for Game Events section is divided into a few logical parts. A list of game events is on the
left. Checking a game event allows a sound for the event to be heard. Next to the event are two 
option circles - the first one signifying use of the PC Speaker, the one next to it signifying the sound 
card.

Using the picture above as an example, look at the Button Click event - we can see that it's checked 
and the first option to its immediate left is enabled, the one underneath the picture of the speaker. 
This means that everytime a button is clicked with the mouse a sound will be heard from the PC 
Speaker. Now look at the event below, the Coin Credit event. We can see that it too is checked but 
its sound will come from the sound card. Furthermore, we can see that COINSIN1.WAV is the WAV 
audio file attached to this event, and next to the text box is a small button with a picture of a musical 
note within. Clicking on this button will play the COINSIN1.WAV file. If you wish to change the WAV 



file assigned to the Coin Credit event, you can simply double click on the WAV file name and a dialog
box will appear allowing you to navigate your system's hard drive(s) and nominate a different WAV 
file.

The only variation to the above is the Hand Win game event. You will notice that there are actually 
nine WAV files attached to Hand Win event - one for each type of win. The example shows one WAV 
file - HANDWIN.WAV for each type of win but you can attach a different WAV file to each different 
type of win event if you like. Also, you can select Repeat Play to play the WAVs over and over - at 
least until another WAV file is played. If you select repeat play it is best to also select the sound card 
as the source for the Button Click event. This way, as soon as you choose HALF, TAKE or FULL after
a win, the repeating sound will stop playing. Feel free to experiment with different sound set-ups - no 
harm can be done and the registered version of Pub Poker saves these settings each time a game is
saved.

One ca'veat to the "no harm can be done statement" - if you choose to assign a long WAV file to the 
Gamble Flip event, you may risk overloading your sound card's input buffer causing the WAV (and all
subsequent WAVes) to be clipped.

If Pub Poker doesn't recognize your sound card
Version 2.0c was modified to hopefully recognize most sound cards but in the event that Pub Poker 
turned a blind eye to yours.... don't worry, you will just have to edit the PUBPOKER.INI file.

The INI file includes the following section:

[MultiMedia]
SoundCard=0
MIDICard=0

If you have a sound card with MIDI capability, edit this section so it looks like:

[MultiMedia]
SoundCard=-1
MIDICard=-1

If your sound card doesn't support MIDI then edit the section to look like:

[MultiMedia]
SoundCard=-1
MIDICard=0

After making these cahnges, save the PUBPOKER.INI file and Pub Poker should play your tunes....



Changing the Interface
If you click an element of the gamble bar with your mouse and hold the button down, the Title bar at 
the top of the Pub Poker window alerts you the function that the cell performs when double clicked. 
Going from left to right the functions are:

· Buttons - Inner Bevel Change - Change the appearance of the borders surrounding the buttons. 
3 settings. Each double click cycles through to the next setting.

· Buttons - Outer Bevel Change - A double click will change the appearance of the borders 
surrounding the buttons. (3 settings)

· Cards - Double click to raise or lower the playing cards. (2 settings)
· Labels - Double click to change the 3D effect of the fonts. (5 settings)
· Labels - Double click to change the 3D effect of the backgrounds behind the labels. (2 settings)
· Background Colour - Double clicking opens a colours dialog box and change the background 

colour of the game window. Be warned - most combinations look ugly but some, greens and 
greys, don't look too bad. Experiment...

· Labels Colour - Double click to open a colours dialog box...
· Payout Figures - Double click to open a colours dialog box...
Any changes made will be saved whenever a Pub Poker game is saved.
In the shareware version, favourite settings will have to be manually restored each time Pub Poker is
started.



Playing Pub Poker
Most people who have played a video poker game will be able to play Pub Poker without a hitch but, 
if you're new to this type of game, simply click on the green topics below for an explanation of the 
stages of the game.

Playing a Hand
Poker Hands
Borrowing Coins from the Bank
Placing a Bet (Buying a Hand)
Holding & UnHolding Hands

Gambling
HALF TAKE or FULL
Gambling on a Red or a Black
Strategies for Playing Pub Poker



Poker Hands
Pub Poker uses a 53 card deck. That is, a standard deck of cards and a wild joker. The minimum 
winning hand in Pub Poker is Two Pairs. A Joker may form part of any winning hand except in the 
case of Two Pair (because Two Pair using a Joker turns into Three of a Kind). In Pub Poker, winning 
hands are as follows:

Two Pair
Three of a Kind
Straight
Flush
Full House
Four of a Kind
Straight Flush
Five of a Kind
Royal Flush



Two Pair
A hand consisting of two different pairs:



Three of a Kind
A hand containing three cards of the same value. In the example below, there are three queens. A 
three of a kind can incorporate a joker as well.



Straight
A straight consists of five cards in sequence according to their value. In the example below the 
sequence is 8, 9, 10, Jack & Queen.

A joker can play a part in making up a straight as shown below:

Types of Straights
Closed or Inside Straight
If you are dealt a hand like the one below and want to go for the straight you would be looking for an 
eight. As there are 53 cards in the deck and 5 cards have already been dealt, the chances of getting 
an eight would be 1 in 9.6 (5 in 48) (remember there's a joker in the pack as well). The same odds 
occur when you are dealt a potential straight which is either Ace high or Ace low. The chances of 
getting such straights are pretty low and if you have Monologue installed on your system and have 
Advice enabled, you will be advised of the possibility of getting a straight but the cards won't be held 
for you - the decision will be left to you whether to go for it or not.

Open or Outside Straight
On the other hand, if you were dealt the hand below you would have a 1 in 5.33 chance of achieving 
the straight (getting an Eight, King or Joker in place of the Four). If you were using the auto hold 
feature, then the cards would be held for you in such a circumstance. If you were using the advice 
feature, you would be urged to hold the Queen, 10, 9 and Jack.



Keep in mind that the odds of getting any hand will be longer if you already hold the joker in your 
hand.



Flush
A flush comprises five cards of the same suit as in the hand shown below:

If a flush contains five cards in consecutive series as shown in the hands below then it is considered 
a straight flush.

If you are using Auto Hold and you were dealt the hand above, all five cards would be held. If 
however you have Monologue installed on your system and had Advice mode turned on, then you 
would be alerted to the possibility of a straight flush in the hand.



Full House
As per the examples below, a Full House consists of a Three of a Kind and a Pair.



Four of a Kind
Consists of four cards of the same value.



Straight Flush
A straight flush comprises five cards of the same suit that are in consecutive sequence.



Five of a Kind
Requires the joker and four other cards all of the same value.



Royal Flush
A Royal Flush is formed by a 10, Jack, Queen, King and Ace of the same suit. Pub Poker doesn't 
distinguish between a Royal Flush containing a joker and one without - you'll be doing well to get 
either kind!



Borrowing Coins

Before play can begin a player must select Borrow Coins from the menu bar. When clicked, the 
player is presented with the choice of putting $10, $20, $30, $40 or $50 into Pub Poker. 

Pub Poker uses 20 cent coins so if for example $10 is selected, the coins display will show 50 as 
shown below.

Coins can be borrowed during the game at any time but each time you do you are "Owing the Bank". 
And these debts don't go away! Each time you save your game your debt level is also recorded.



Placing a Bet
You can place a bet whenever the coin buttons are highlighted as shown below.

Simply click on a button to bet that amount of coins. You can also use the keyboard instead of the 
mouse if you like - just hit a number key corresponding to the number of coins you wish to bet.

If you bet 1 coin then the payoffs for a winning hand will be those in the column headed 1 in the 
payoffs table. If you bet 2 coins then the payoffs will be as in column 2 of the payoffs table, and so it 
goes...

After clicking a Coin button, 5 new cards will be dealt from the newly shuffled deck, ready for you to 
Hold or Unhold any of the 5 cards as you see fit.



Hold and UnHold

After your first five cards have been dealt, depending on whether Auto Hold is On or Off, you will 
probably want to hold some of the cards. Even if Auto Hold is On and cards are automatically held for
you, you can always go on to Unhold and then Hold various cards as you wish.

To Hold or UnHold a card just click the mouse pointer on the card. If you are using the keyboard, just 
press a number key corresponding to the position of the card in question. The card positions are 
numbered 1 to 5, left through right. If the card is not currently held it will be held, otherwise, if it is 
already held it will be "UnHeld".

When you are happy with your choices you can click on the Deal More Cards button or press the 
Enter key. Any cards not held will be replaced by new cards.



Half Take or Full
Pub Poker lets you gamble on the probability that an undealt card, chosen randomly from the pack, 
will be of a red or a black suit. Here's how it works...

After clicking the DEAL MORE CARDS button, if you got lucky and had a win, the HALF, TAKE & 
FULL buttons will become highlighted, ready for your selection. It is here that you must decide to 
either play it safe and click TAKE or try to double your money (or some of it) by clicking HALF or 
FULL.

· TAKE - All of your winnings, as indicated in the message window, will be added to your total and 
the numbered coin buttons will be again highlighted, readied to play another hand. Keyboard 
users should press the up arrow key to choose TAKE.

· FULL - All of you winnings, as indicated in the message window, will be gambled. You will either 
lose the lot or double your money! You can win a maximum of five gambles in a row, at which 
point you will be directed to TAKE your winnings, you lucky thing you. For keyboarders, press the
right arrow key if you want to choose FULL.

· HALF - Half your winnings, as indicated in the message window, will be added to your total and 
the other half will be gambled. If you lose the gamble, you will have at least banked some coins. 
Keyboard users should press the left arrow key to select HALF.



Gambling

If you choose HALF or FULL after winning a hand then you are obviously willing to risk part or all of 
your winnings, which means you're gambling!

Simply put, you are wagering the chance that a flipped card will be of either a Red or a Black suit. 
After choosing HALF or FULL, a card will begin flipping, signifying it's your turn to take a guess at 
what the card is. You register you guess by clicking either the RED or the BLACK button. The card 
will then be revealed. If the card suit is Hearts or Diamonds and you clicked the RED button then 
you're a winner and you double your money! Similarly, if the card suit is a Club or a Spade, and you 
clicked the BLACK button that's a win as well. Otherwise you lose.

Keyboard users should press the "Z" key to choose RED and "C" for a BLACK.

You can gamble in this fashion up to 5 consecutive times on each winning hand. To give you some 
indication of previous gambling outcomes, Pub Poker has a ribbon display above the cards which 
shows the results of the last 8 gambles.

The gamble bar is updated every time a gamble is performed. The most recent gamble result is 
indicated by the right-most section of the bar. Looking at the gamble bar above you can easily see 
that the last 3 gambles have all turned over Diamonds or Hearts (or a Joker) and the 4 gambles 
previous to those were either Clubs or Spades (or a Joker). 

In the picture below, the blue lines indicate the relationship between the gamble bar and gambling. In
this case there were five correct guesses in a row; a very rare event! (but great when it happens!0



When gambling, keep in mind that the card pack is only shuffled at the beginning of each new hand. 
This knowledge may help you choose which colour is more likely to be flipped according to the cards 
that have already been dealt through the course of the current hand and gambling session. e.g. If 
your winning hand was a Flush, made up of Clubs or Spades, and you discarded other Spades or 
Clubs to arrive at that winning hand, then there is a higher chance of a Diamond or a Heart being 
played during the gamble phase.



Strategies for Play
If you have Monologue installed and Advice enabled, this is basically the kind of advice you'll hear 
(along with alot of superfluous talk about what a great champion player and one of a kind human 
being you are...).

Best cases
If you get dealt a Five of a Kind, a Royal Flush or a Straight Flush - Hold all of your cards! Things 
don't get much better than this.

Still very very good
If you get dealt a Four of a Kind - UnHold the dead card and Hold the rest. There's a chance you may
be able to increase your hand to a 5 of a Kind.

Being 1 off...
If you are just 1 card off a Royal Flush - go for it! If Auto Hold is ON the cards will be selected 
anyway. 

If you have 4 cards of a Straight Flush this is worth going for as well but weigh up breaking up a 
Straight or a Flush to do so.

Other situations
If you get dealt a Pair or Three of a Kind, Hold them and UnHold the rest.

If you're 1 card off a Flush - go for it. There's about a 1 in 4 chance you'll get it.

If you get dealt a Joker along with a jumble of other cards - Hold the Joker and UnHold the rest. 
There's no benefit to keeping a particular card and a Joker, you're better off getting 4 new cards.



Saving and Loading

The registered version of Pub Poker allows you to Save your games for later Loading.

· Saving - Choose Save Game from the File menu or press Alt-V.
A dialog box will appear prompting you for a file name. Pub Poker games are saved with the 
default extension PPG, you don't have to enter an extension - it will automatically be appended 
to the name you enter if you omit it.

· Loading - Choose Open Game from the File menu or press Alt-O.
A dialog box will appear allowing you to navigate the drive(s) of you system to locate stored 
*.PPG files.

Please Note...
Games saved by Pub Poker are stored as standard text files. They can be edited if you want to cheat
but they aren't set out in a particularly logical fashion so be careful. Pub Poker will be very 
unforgiving should you make it load in a saved game that you've mucked up!



Shareware Version Limitations
The unregistered shareware version of Pub Poker will display a registration reminder screen every 
ten hands or so during game play:

Clicking on Still Evaluating will allow play to continue for another ten hands or so without any 
problems. In fact, you can continue playing this way forever but by rights, you should decide after 21 
days whether or not you want to register the game and either send away for your ID code or delete 
Pub Poker from your system.

The reminder screen can only be permanently removed by entering your name and the registration 
ID number you'll receive after registering and then clicking on Process Details.

The shareware version does not Save or Load Pub Poker games or interface configuration options, 
and won't allow entry of your name under the Options menu which means that if you have 
Monologue and use the advice function, you'll always be called "my friend". (Which, after 21 days, I 
hope you'll tire of ! Hint ! Hint !)



Registering Pub Poker
By registering Pub Poker you will be able to remove the reminder screen that pops up periodically, 
enter your own name for use by Monologue and Save and Load Pub Poker games along with all of 
your favourite configuration options. Plus, your name will proudly appear on the start-up screen when
the game starts. You'll also be supporting the concept of shareware and enabling further 
enhancements to Pub Poker and other Windows games I want to develope.

Last but not least, I'll really appreciate your support!

Russell Oates.    May 1994.

By Mail

The cost of registering Pub Poker is $10.00 in US funds or $14.00 Australian. If you're not a United 
States resident and want to send a cheque please adjust the price to suit the prevailing currency 
exchange rates for your currency.

You will receive a unique ID number which will banish the registration reminder screen and unlock 
the registered version features of the game. 

Optionally, you can send $15.00 in US funds or $19.00 Australian and you will receive the latest 
version of Pub Poker on diskette.

Using Compuserve

If you're a Compuserve member you can register Pub Poker while on-line. Simply GO SWREG and 
choose to search the shareware database by ID number. The ID number for Pub Poker 2.0 is 2663. 
Your Compuserve account will be billed $10 US and you will be notified of your own unique Pub 
Poker ID number by email.
If you want to receive Pub Poker 2.0 on diskette you will have to send a cheque by snail mail direct 
to Oatesoft.

Order Form



Order Form
To print the order form on your printer, click the File menu from the Help window and then click Print 
Topic.

Mail to:

          Oatesoft Computer Services
          PO Box 1078
          Neutral Bay Junction
          New South Wales
          Australia, 2089

          Please tick only one option below...

»Option 1:
I have enclosed a cheque / postal money order for $10.00 US / $14.00 Australian in favour of 
Oatesoft Computer Services. I understand I will receive notification of my registration ID number 
matched to the name that appears below which will allow removal of the shareware reminder screen 
and enable the registered version features of Pub Poker.

»Option 2:
I have enclosed a cheque / postal money order for $14.00 US / $19.00 Australian in favour of 
Oatesoft Computer Services. I understand I will receive the latest registered version of Pub Poker on 
diskette in the following size format:

»Please tick one:          I have a 3.5 inch disk drive.          I have a 5.25 inch disk drive.

          My mailing address details are:

Name:
_____________________________________________________________________

Address:
_____________________________________________________________________

_____________________________________________________________________

Town / City:                                                                                            Post / Zip Code:
_____________________________________________________________________

Country:
_____________________________________________________________________

Please note down any comments / suggestions you may have about Pub Poker:...

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________



Where did you get your shareware copy of Pub Poker 2.0 from? 

_____________________________________________________________________



Disclaimer and Licence
Pub Poker 2.0 © 1993-94 by Russell Oates. 
Oatesoft Computer Services. All Rights Reserved.

Users of Pub Poker 2.0 must accept this Disclaimer of Warranty:

"PUB POKER IS SUPPLIED "AS IS". THE AUTHOR DISCLAIMS ALL WARRANTIES, EXPRESSED 
OR IMPLIED, INCLUDING AND WITHOUT LIMITATION, THE WARRANTIES OF 
MERCHANTABILITY AND OF FITNESS FOR ANY PURPOSE. THE AUTHOR ASSUMES NO 
LIABILITIES FOR DAMAGES, DIRECT OR CONSEQUENTIAL, WHICH MAY RESULT FROM THE 
USE OF THE SOFTWARE. THIS SOFTWARE, ITS SOURCE CODE AND DOCUMENTATION ARE 
PROTECTED UNDER INTERNATIONAL COPYRIGHT LAWS."

Pub Poker 2.0 is not and never has been Public Domain Software, nor is it Free software. This 
unregistered, evaluation copy of Pub Poker 2.0    is Shareware software. You are granted a limited 
license to evaluate Pub Poker 2.0 for a period of 21 days. Continued use of Pub Poker 2.0 beyond 
this period requires payment and registration of the software.

No one may modify or patch the Pub Poker 2.0 executable file in any way, including but not limited to
decompiling, disassembling or otherwise reverse engineering Pub Poker.

Continued use of Pub Poker 2.0, even trial evaluation use, constitutes your agreement with these 
terms.

Russell Oates
Oatesoft Computer Services
PO Box 1078, Neutral Bay Junction
New South Wales, Australia, 2089

Telephone: +61 1 520 0417
Compuserve ID: 100036,61
Internet: roates@ozemail.com.au



Distributing Pub Poker
The shareware version of Pub Poker 2.0 is meant to be copied and passed onto friends and 
colleagues. Please feel very free to do so....

A limited, non-exclusive licence is granted to copy and distribute the shareware version of Pub Poker
only for the trial use of others, subject to the following limitations:

1. The shareware version of Pub Poker must only be distributed in its entirety. Absolutely no changes
may be made to the program code, documentation or number of files in the distribution archive.
 
2. Any person or business distributing Pub Poker for any kind of remuneration must first contact 
Oatesoft Computer Services at the address below for authorisation. This authorisation will be 
automatically granted to Shareware distributors recognised by the Association of Shareware 
Professionals as adhering to its guidelines for Shareware distributors, and such distributors may 
begin offering Pub Poker 2.0 immediately, however, Oatesoft Computer Services MUST be advised 
in writing and such distributors MUST send a example copy of any distribution media containing the 
Pub Poker archive(s) to Oatesoft Computer Services (this includes CD-ROM compilations).

3. Pub Poker may not be distributed in conjunction with any other commercial product or service 
without a specific negotiated licence to do so from Oatesoft Computer Services.

4. No fee, charge, or other compensation may be requested or accepted for Pub Poker, except as 
authorised below:

(A) Commercial Shareware Vendors and CD-ROM Publishers / Distributors MUST include a clear 
statement to intending buyers that the purchase of the media containing the Pub Poker shareware 
archive, either singly, or as part of a compilation of a shareware collection, on disk, CD-ROM or via a 
disk vending machine or retail rack-style packaging, does not constitute registration of the shareware
software and additional payment, to the author, is required to register the shareware software.
- No more than $8.00 US per high density disk may be charged for a magnetic floppy disk containing 
Pub Poker. 

(B) Operators of electronic bulletin board systems (sysops) may make Pub Poker available for 
downloading only as long as the above conditions are met.    An overall or time-dependent charge for 
the use of the bulletin board system is permitted as long as there is not a specific charge for the 
download of Pub Poker.

(C) Non-profit user groups may distribute Pub Poker, subject to the above conditions, without specific
permission. Non-profit user groups may charge a disk duplication fee, which, when pro-rated to the 
Pub Poker product, may not exceed $8.00 US per disk.

Russell Oates
Oatesoft Computer Services
PO Box 1078, Neutral Bay Junction
New South Wales, Australia, 2089

Telephone: +61 1 520 0417
Compuserve ID: 100036,61
Internet: roates@ozemail.com.au



Thanks to...

A number of people have given me support and suggestions with Pub Poker starting with version 1.0 
through to this version...

· Thanks first and foremost to Stephen Murphy. Without Stephen, Pub Poker would be mute in the 
speech department. Stephen's DLL, FB_TRANS, has brought Pub Poker alive and I'm very 
grateful to him. He was also a great help in beta testing and providing suggestions for 
improvements over many months. Stephen is also the author of a couple of excellent card 
games; Concentration & Klondike Solitaire, both of which can be found in the WINFUN forum on 
Compuserve. Thanks again Stephen!

· Thanks to Terri, my first registered user and those others who registered version 1.0. Your 
support is greatly valued!

· Thanks also to Michele & Geoff for their feedback and to Geraldine especially for allowing me the
room to get this version finished and out the door and her support all along the way.

· Thanks too to those users who contacted me with bug reports (sorry!) about version 1.0 and 
ideas for version 2.0.

· Finally, thank you to you, the person reading this now - for taking the time to check Pub Poker 
out. I hope you enjoy the game.



Feedback

I welcome comments, suggestions, gripes, postcards or whatever from Pub Poker users. 

If you don't like it and want to tell me - please do! If you like it but something's stopping you from 
registering it - let me know! If you have any kind of suggestions at all, I'm all ears.

Please write to:

                    Russell Oates
                    PO Box 1078
                    Neutral Bay Junction
                    New South Wales
                    Australia 2089
                    Telephone: +61 1 520 0417

or contact me by email:

Compuserve: 100036,61            or            Internet: roates@ozemail.com.au



About the Author
You may find this boring so be warned!

My name is Russell Oates. I'm 33 and live in Sydney, Australia.

I bought my first computer in 1980, a Tandy / Radio Shack TRS-80 with 4K RAM and a tape recorder 
for file input/output. I got completely hooked and wrote lot's of little programs in BASIC as at the time 
there wasn't a lot of commercial software around. 
After about 18 months of this though I realised there was more to life than communing with my TRS-
80 and sold it and started living a normal life again.

I avoided PC's for most of the early 80's until I went out and bought an old second hand Osborne1 
and wrote an order processing program for a sales office I was working in because we were making 
too many mistakes doing things by hand.

The bug quickly bit me again. I bought a weird Amstrad thightop PC that didn't have a hard drive, but 
it had a modem! This really got me hooked. I was amazed at the amount and variety of Shareware 
being written and found BBS's fascinating. Shortly after I went out and bought a real PC. Then when 
Microsoft released Windows 3.0 and then followed shortly with Visual Basic 1.0, I was in heaven.

I didn't get much time to play with VB 1.0 and found it a bit too tiresome to work with anyway but 
when, through a combination of naiveté, stubbornness and the phases of the moon, I found myself 
out of work, I upgraded to Visual Basic Professional 2.0 and decided to learn how to do it.

Since then Pub Poker version 1.0 was released in November 1993 and I've delved further into Visual
Basic, upgraded to Version 3.0 Pro, and got motivated to finish version 2.0. 

No doubt, with the release of Windows 4.0 and Visual Basic 4.0 around Christmas, Microsoft are 
going to ensure that I (and a lot of others) are kept busy just keeping up, not to mention paying for it 
all! And then there's C to tackle....

I hope you get some real enjoyment out of playing Pub Poker and if you feel motivated to register 
then my efforts will have been vindicated. I'll be really happy too! 

Please feel free to write or email me with your suggestions, complaints, bug reports or feedback of 
any kind. All correspondence is welcome. I'd like to continue working on improving Pub Poker and 
the more feedback I can get the better.

Thanks for trying Pub Poker and supporting the shareware concept.    

Russell Oates.    June 1994.



p.s. I'm also looking for work using any of: Microsoft Visual Basic, Access 2.0, Excel 5.0, Visual Basic
for Applications or Office 4.x integration projects so if you'd like to talk to me and you're located in 
Sydney please phone 015 200 417, I'd like to talk to you. You can also email me at 
roates@ozemail.com.au or on Compuserve to 100036,61.



Pub Poker Background
Pub Poker 2.0 was written entirely in Microsoft's Visual Basic Professional Version 3.0. It makes use 
of API calls to determine system information, call sound routines and other miscellaneous stuff and 
uses the supplied 3D custom controls for the 3D interface effects. 

The program makes extensive use of Stephen Murphy's FB_TRANS.DLL (available in the BASIC 
forum on Compuserve) for all handling of First Byte's Monologue for Windows. Pub Poker 2.0 
contains just over 900 sentences of variable length which can be sent to Monologue, dictated by the 
way the cards are played. When the first hand is dealt it is analysed to see which of 19 possible 
outcomes it best matches. Once categorised, suggestions about cards to hold are made, the 
dumped cards are replaced and the final hand's put through a win checker. A comment can then be 
made referencing the statement made after the first deal. It was through this branching structure that 
so many sentences became necessary and there's certainly scope to add more...

It's fairly memory and resource hungry, using up about 1 MB, reaching its peak of drain after about 
the 50th hand is played and then stabilizing from there on (I hope!). The next version will most likely 
incorporate Stephen Murphy's QCARDS.DLL to try to reduce Pub Poker's voracious appetite and I 
guess, it would be sensible to put all of the sentences in a DLL as well (gotta be able to afford C first 
though!). ;-}

It was written and tested on a 386DX25 clone with 8MB RAM (one of the slowest of the species in 
captivity I'm convinced!) and tested at various display resolutions from VGA upward including large 
font display drivers (although the help file under large font drivers is still pretty ugly - so much for 
Windows being device independant!). It doesn't support EGA. Provision for the large font drivers was
made by dynamically resizing each control on the main game form prior to displaying it. The 
information for the resize routine was garnered from another VB program I wrote which reads in 
*.FRM files saved as text and then writes out an include file. Anyone wanting a copy can contact me 
on compuserve - its probably not the most elegant solution to the resolution problem (okay, its not, 
hands down) but it worked. 

Last but not least, this help file was written using Firas Bushnaq's Visual Help Version 2.0 (also 
available on Compuserve, from the BASIC forum & heartily recommended).

Russell Oates, June 1994



Using the Keyboard

Pub Poker is not just for mousers... you can also use the keyboard to direct play.

Placing a bet (buying a hand)

You can place a bet buy pressing the number keys: 1, 2, 3, 4 or 5, either those located along the top 
of your keyboard or on the numeric keypad.

Holding and UnHolding cards
When Holding or UnHolding cards, you use the number keys just as you do when placing a bet.

Dealing more cards

Use the ENTER (or RETURN) key to complete your hand after Holding or UnHolding your cards. Any
cards not held will replaced with new cards.

HALF, TAKE or FULL

Use the arrow keys to control HALF, TAKE or FULL:
To TAKE your winnings and add them to your bankroll, use the UP arrow.
To gamble your FULL winnings, use the RIGHT arrow.
To gamble only HALF your winnings, use the LEFT arrow.

BLACK and RED



To double your money (or maybe lose it!):
Use the Z key to if you think the next card to be flipped will be a RED suit.
Use the C key if a BLACK suit is your choice.






